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C H A P T E R  f o u r

Working with Illustrator

There’s a classic Saturday Night Live commercial parody for a product 
called Shimmer, in which a husband (played by Dan Aykroyd) and wife 
(Gilda Radner) argue over whether the product is a floor wax or a dessert 
topping. As the debate escalates, a slick pitchman (Chevy Chase) breaks 
it up by stating that Shimmer is both a floor wax and a dessert topping.

Illustrator is a lot like Shimmer because it serves so many disparate 
needs. It’s a print-based application that’s also a Web graphics creation 
tool with a pixel grid. It’s a vector-based object-creation model that sup-
ports transparency and Photoshop-like effects, and now creates natu-
ralistic brush strokes. It’s a two-dimensional tool that has rudimentary 
three-dimensional modeling and now allows you to draw in perspective.

Whatever task you throw at Illustrator, or whatever your particular art-
work needs are, there are a multitude of features that help you explore 
creatively, work efficiently, and publish reliably.
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Understanding the 
Perspective Grid

#25
Illustrator’s new Perspective Drawing feature gives artists the ability to 
define a perspective grid, draw art on that grid, and add existing art to 
that grid in the appropriate perspective. This speeds up perspective-
based drawing, but before you start drawing you need to understand the 
grid you’re drawing on and its various settings and controls.

Every Illustrator document contains one perspective grid. By default, 
that grid is not shown. To reveal a document’s perspective grid, go 
to View > Perspective Grid > Show Grid, or press Shift-Command-I  
(Shift-Ctrl-I). The default is a two-point perspective grid, but Illustrator has 
built-in grid presets for one-, two-, and three-point perspective drawing 
(Figure 25a) that you can also use as the basis for your drawing.

Horizon Line

Ground Line

Horizon Line

Horizon Line

Ground Line

Ground Line

Figure 25a  From top to bottom: Illustrator’s one-point, 
two-point (the document default), and three-point perspective  
grid presets.

One-, Two-, and Three-
point Perspective: 
What’s the Difference?
To understand perspec-
tive, think about where the 
viewer is in physical space.

One-point perspective is 
what the viewer would 
see standing in the center 
of a long hallway, looking 
straight ahead. All planes 
(walls, ceiling, floor, etc.) 
converge to a single point—
known as the vanishing 
point—on the horizon. The 
horizon line is always at eye 
level.

Two-point perspective is 
what the viewer would see 
standing in the center of a 
four-way intersection, look-
ing directly at the corner of 
one block. To the left, the 
buildings down one street 
recede in one direction. 
To the right, the buildings 
recede in another direction 
toward a second vanishing 
point. Both points share the 
same horizon line.

(continued on next page)
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#25:  Understanding the Perspective Grid

You can make the grid visible simply by switching to the Perspective 
Grid tool  (Shift-P). This tool makes all of the grid’s modification points 
active so you can reposition its horizon line or left and right planes, extend 
or redistribute its grid lines, and otherwise customize it to your needs. Any 
grid you customize can be saved as a preset to use in any other Illustrator 
document (View > Perspective Grid > Save Grid as Preset).

Customizing the Perspective Grid
Illustrator’s perspective grid projects forward, so adjusting a grid to match 
a scanned sketch is pretty simple if the sketch’s composition matches that 
default. However, not all perspective drawings are composed that way. 
The sketch in Figure 25b, for example, recedes toward its center.

Figure 25b  Illustrator’s default front-projecting grid does not match this 
composition.

(continued )

Three-point perspective is 
what you’d see flying in a 
helicopter looking down 
at that intersection. Build-
ings still recede off into the 
distance toward two vanish-
ing points and one horizon 
line, but all the buildings’ 
lines (from the rooftop to 
the street) also converge 
downward toward a third 
vanishing point.

The Grid Is 
Everywhere
Although the grid you see in 
your document appears to 
occupy a finite area defined 
by the grid lines for each 
plane, the perspective grid 
is, in fact, everywhere in the 
document. Moving objects 
in perspective beyond the 
visible edges of the grid 
doesn’t remove them from 
its control. Instead, those 
objects appear farther above 
or below the grid’s horizon-
tal boundaries, or nearer to 
or farther back from its ver-
tical boundaries, and they 
remain drawn in proper 
perspective.
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Fortunately, grids can be customized. When the Perspective Grid tool 
is active, each grid plane has a control handle with which you can reposi-
tion that grid. If we move the handle for the right plane to the left, for 
example, the right grid plane can act as the grid for the left wall in the 
sketch (Figure 25c).

Figure 25c  The right grid plane is moved to the left using its control handle (inset) to 
a position that matches the left wall of the sketch.

Common Ground
Regardless of the type of 
perspective grid you choose, 
all grids share these basic 
components:

•	 a horizon line

•	 a left plane (two- and 
three-point perspective 
grids also contain a right 
plane)

•	 a ground plane

Station Point=Pivot 
Point
The station point of a two- 
or three-point perspective 
grid is the front-most cor-
ner of the cube formed by 
the grid. When you lock a 
grid’s station point (View > 
Perspective Grid > Lock Sta-
tion Point), your changes to 
the grid’s vanishing points 
are inversely mirrored. In 
other words, moving the 
left plane’s vanishing point 
inward moves the right 
plane’s vanishing point out-
ward by an equal amount, 
and vice versa. With the 
station point locked, the 
two planes effectively pivot 
from the point where they 
meet as you move either 
vanishing point.
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#25:  Understanding the Perspective Grid

Once the grid plane is placed in the approximate position, its  
vanishing point can be moved to get the perspective angle as close to 
the sketch as possible (Figure 25d). With the plane positions transposed, 
their respective extents will overlap and create a very busy grid. This can 
be prevented by dragging the hollow diamond shapes (which control the 
grid extents) on the repositioned plane in toward where the two walls 
meet (Figure 25e).

Figure 25d  Moving the vanishing point (inset) sets an angle that better matches the 
original sketch.

Figure 25e  Pulling in the grid extents diamonds (inset) displays fewer grid lines and 
prevents the two grids from overlapping.

Tone Down Your 
Grid
As you add artwork, the 
perspective grid can 
become distracting. To 
minimize this, open the 
Define Perspective Grid 
dialog box (View > Per-
spective Grid > Define 
Grid) and change the 
grid’s opacity from the 
default of 50 percent 
to something easier on 
the eyes, like 25 percent. 
Unfortunately, there’s no 
application-wide way to 
change the default.
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Similar position, vanishing point, and grid extent adjustments can be 
made to the left plane so that it can serve as the grid for the right wall 
in the sketch. Once that’s done, the grid is completely customized for 
the perspective needs of this illustration (Figure 25f). Once the grid is 
established, the next step is mastering the appropriate drawing strategies 
to produce a finished perspective illustration (Figure 25g).

Figure 25f  The customized perspective grid with its planes repositioned, horizon line 
adjusted, and grid extents pulled in to match the sketch.

Figure 25g  A finished perspective drawing from the original sketch and the 
customized grid.

Grid Goodies, Part 1
When Illustrator’s Smart 
Guides feature is turned on 
(which is the default) and 
you reposition the grid’s 
horizon line, an “HH” value 
is displayed. This num-
ber indicates the horizon 
height, which is the distance 
between the horizon line 
and the ground line. If you’re 
working on a drawing to 
scale, it can be helpful to put 
the grid’s horizon line at a 
normal observer’s height.

Grid Goodies, Part 2
The Define Perspective Grid 
dialog box (View > Perspec-
tive Grid > Define Grid) is 
your go-to place for all the 
perspective settings. From 
here, you can choose what 
type of grid to use (one-, 
two-, or three-point per-
spective), and select its 
measurement system, scale, 
gridline increments, viewing 
angle, horizon height, and 
the color of the left, right, 
and horizontal planes.
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#26:  Drawing in Perspective

As with any new feature, Perspective Drawing brings with it new tools, 
new behaviors, and new limitations that you need to become familiar 
with to work effectively.

One basic challenge is keeping track of which plane you’re drawing on. 
Fortunately, Adobe added a hard-to-ignore element—the Active Plane 
Widget—at the top left of the document that appears whenever the 
perspective grid is visible (Figure 26a). The highlighted side of the cube 
shown in the widget indicates the currently active plane.

Figure 26a  The Active Plane Widget in its various modes (top row, left to 
right): Left Grid, Right Grid, Horizontal Grid (or ground plane), and No Active 
Grid. Below each is the cursor’s appearance when drawing objects on that grid.

All but one of Illustrator’s object drawing tools work with the Perspec-
tive Drawing feature (Figure 26b): the Flare tool is not supported. With 
the perspective grid visible and the desired plane active, simply choose 
any other object drawing tool and start drawing. All shapes will be drawn 
in the perspective of the active plane.

Figure 26b  Rectangles, ellipses, polygons, stars, arcs, spirals, rectangular 
and polar grids, and live, editable type can all be drawn in perspective.

Drawing in Perspective
#26

What the 
Perspective 
Drawing Feature 
Isn’t
Illustrator is not a 3D 
modeling environment. 
Its Perspective Draw-
ing feature provides no 
camera angle that can 
be changed, no surfaces 
to be mapped, and no 
means of controlling 
light or shadows. The 
perspective grid is basi-
cally a static framework 
on which you can draw 
and add shapes and text 
that will conform to that 
grid.

Once you set up your grid 
and start drawing on it, 
you’re committed. You 
can’t remove an object 
drawn on or added to 
the grid and return it to 
its “normal” state. Nor 
can you change the van-
ishing point or other 
aspects of the grid itself 
and have the artwork 
that’s already on it adapt 
to those changes.

(continued on next page)
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Plan out your perspec-
tive drawing before you 
get started and keep your 
expectations for the feature 
in…well, perspective. Know-
ing its limitation will help you 
take advantage of what it 
does well.

Fast Plane Switching
To switch quickly between 
different planes on the per-
spective grid, remember 
these shortcuts. Pressing the 
1 key activates the left plane; 
2 activates the horizontal (or 
ground) plane; 3 activates 
the right plane; and 4 exits 
Perspective Drawing, setting 
the widget to “no active grid.”

These keyboard shortcuts 
also help you move selected 
objects from one plane to 
another. Hold down the 
mouse and select any per-
spective object, then tap 
a number key to move the 
object onto that plane. To 
copy an object to another 
plane, hold down the Option 
(Alt) key before pressing one 
of the shortcut numbers.

Holding down the 5 key 
while moving an object 
moves it perpendicular to its 
current plane.

Moving or modifying objects already in perspective requires switching 
to the new Perspective Selection tool  (Shift-V). Use this tool to scale 
objects in perspective, not the Scale tool. Using Illustrator’s standard 
selection or transformation tools will break any object’s connection to 
the grid and expand its appearance. Fortunately, Illustrator displays a 
prominent warning every time you run this risk (Figure 26c).

Figure 26c  A useful warning dialog box prevents you from ruining your perspective 
drawing if you attempt to modify an object with the wrong tool.

Working Smarter in Perspective
Perspective Drawing is a great new feature that’s actually easier to use 
and more flexible when it’s combined with older Illustrator features. In 
the following example, we’ll combine Perspective Drawing with symbols, 
clipping masks, and transparency to make the feature appear to do things 
it can’t actually do.
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#26:  Drawing in Perspective

Once an object is in perspective, it can’t be removed from the grid 
and reverted to its flat state. Because of this it’s important to work with 
symbols as much as possible (Figure 26d). Symbols used on the perspec-
tive grid are just placed instances, so you can modify the original symbol 
as flat artwork, then see all instances on the grid update in perspective.

Figure 26d  These three symbols were used to build the finished illustration in 
Figure 26i.

A symbol is a single object, making it easier to select and position on 
a perspective grid. The stars-and-stripes pattern mapped to the left plane 
in Figure 26e is one symbol made up of multiple objects. Symbols can be 
easily contained within a clipping mask, as in Figure 26f.

Figure 26e  The stars and stripes symbol is placed into perspective on the left plane.

No Live Perspective 
for the Pen Tool
Perspective Drawing does 
not support one of Illustra-
tor’s most-used tools: the 
Pen tool. The easiest way to 
work around this is to draw 
your pen-based artwork off 
the perspective grid, then 
select it with the Perspective 
Selection tool and move it 
onto the active grid.

Type and Perspective
Live, editable text can be 
added to the perspective 
grid only after it’s been 
typed. The text must be 
selected with the Perspec-
tive Selection tool and 
dragged onto the appropri-
ate plane. To modify text 
that’s already on the per-
spective grid, double-click it 
with the Perspective Selec-
tion tool to enter Isolation 
mode, where you can work 
exclusively on the text. Once 
you’ve modified your text 
and exited Isolation Mode, 
the text is re-rendered in 
perspective.
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Do Your Rotating Off 
the Grid
You can’t rotate shapes or 
symbols once they’re on 
the perspective grid. If you 
want to rotate an object in 
perspective, you’ll have to 
draw it off the grid, rotate 
it, switch to the Perspec-
tive Selection tool, and then 
move the rotated artwork 
onto the grid.

Figure 26f  A rectangle drawn in perspective over the stars-and-stripes symbol 
and converted to a clipping path crops the pattern to create one side of the box.

By combining symbols and clipping masks, you can simulate art that 
wraps around an object, which is something the Perspective Drawing fea-
ture can’t do (Figure 26g).

Figure 26g  We copied the clipped symbol to the right plane, positioning it within 
the clipping mask to match up with the pattern on the left plane and create a  
wrap-around effect. We drew a black, semi-transparent rectangle with a multiply  
blend mode on the left plane to create a sense of depth.
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#26:  Drawing in Perspective

Figure 26h  We added the gift tag and shadow symbols from Figure 26d to the right 
plane, and created the ribbon by drawing rectangles on both planes.

Figure 26i  The finished perspective art. A gradient-filled rectangle drawn in 
perspective on the ground plane simulates a cast shadow. We added the bow at the  
top and the string on the tag off the perspective grid.

The Stroke Problem
Perspective drawing 
creates the illusion 
of 3D, but that illu-
sion is shattered if your 
artwork contains strokes. 
Perspective drawing 
does not support strokes. 
If very thin strokes are 
used, it may not be a 
significant problem, but 
the heavier the stroke 
weight, and the farther 
back along the grid the 
stroked object appears, 
the worse the effect 
looks. To work around 
this shortcoming, con-
vert the stroke to a shape 
(Object > Path > Outline 
Stroke) before putting 
the object in perspective.
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The problem with Illustrator artwork is that it looks like Illustrator artwork. 
It tends to be a little too perfect and uniform unless you go to a lot of 
trouble, and sacrifice a lot of editability, to make it look otherwise. The 
fireplace illustration in Figure 27a should have a loose, casual feel, but 
that’s undermined by the perfectly consistent line weight of every stroke.

Figure 27a  A typical Illustrator line art drawing using normal strokes. The enlarged 
detail shows the uniformity of all strokes in the artwork.

The new Width tool  (Shift-W) lets you create variable-width 
strokes on a single path without adding anchor points or expanding the 
path. The Width tool adds a new kind of point—a width point—visible 
only when you hover over the path with the tool (Figure 27b).

Figure 27b  A width point 
selected with the Width tool and  
displaying Smart Guide data about  
the width of the stroke 
at that point.

To add a width point to any path, simply click somewhere on that path 
with the Width tool and drag either away from the path to widen the 
stroke, or toward the path to narrow it. To widen the stroke only on one 
side of the path, select the point, hold down the Option (Alt) key, and drag 
one of the width point’s handles to the desired width on that side of the 
path (Figure 27c).

Creating Variable-
width Strokes

#27
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#27:  Creating Variable-width Strokes

Figure 27c  Widening a stroke equally on both sides of a path (left), and on only one 
side (right), with the Option (Alt) key.

To relocate a width point, select it with the Width tool and drag it to 
the desired position along the path. To “pull along” any other width points 
on that path and redistribute the changes in weight, hold down the Shift 
key while moving the selected width point. To delete a path, select it with 
the Width tool and press Delete.

Once you’ve modified a stroke’s width, you can save the stroke as a 
Width Profile in either the Control panel or the Stroke panel (Figure 27d). 
That saved profile can be applied to any other stroke in your artwork, or 
used in any other Illustrator file.

Figure 27d  The Width Profile pull-down in the Control panel, 
with icon options for saving, deleting, or resetting profiles.

Pin-point Width 
Point Precision
For greater control over 
your width points, dou-
ble-click the point to 
open up the Width Point 
Edit dialog box. From 
there, you can put in spe-
cific widths for each side 
of the path. If you already 
have separate widths on 
either side of the path, 
changing the total width 
will add (or reduce) the 
width of each side pro-
portionally.

Keep It Smooth
When you change the 
width of one width point 
that’s on a path with 
other width points, hold-
ing down the Shift key 
will also modify those 
other width points to dis-
tribute the weight evenly 
along the path and avoid 
unwanted “bumps” in the 
stroke.
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To make the most of your saved width profiles, you can flip them along 
the path using the Flip Along or Flip Across icons in the Stroke panel  
(Figure 27e). Flip Along flips the width profile from the start of the path 
to its end. Flip Across is only active for strokes with different weights on 
either side of the path, and flips them across that path.

Figure 27e  Both paths are identical, and use the same width profile, but 
the right path was flipped across the path length using the Stroke panel.

In the final fireplace illustration in Figure 27f, a single width profile 
was used for all elements of the fireplace frame, but made to look more 
varied by flipping the profile on select paths and subtly adjusting stroke 
weights. A second width profile was applied to the bricks and two others 
to the flames.

Figure 27f  The finished illustration uses four custom width profiles.

Why’s My Stroke So 
Skinny?
The stroke weight values 
shown in the Stroke panel 
and Control panel refer to 
the thickest part of a vari-
able-width path. If you apply 
a width profile to an existing 
path and don’t see the result 
you expected, you may 
need to increase its stroke 
weight to get the desired 
appearance.

It’s Not Just for 
Strokes
The Width tool also works 
with brushes applied to a 
path. Even Pattern brushes 
and Banner brushes can be 
transformed into variable-
width brush strokes using 
the same steps described 
here. Only the new Bristle 
brush lacks support for the 
Width tool.
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#28:  Creating Better Dashed Strokes

For as long as Illustrator has been on the market, designers have been 
plagued by the behavior—or rather, the bad behavior—of its Dashed 
Strokes feature. In all versions before CS5, dash lengths and gaps were 
absolute values, so when a dashed stroke was applied to even simple 
rectangles and ellipses, the results were unpredictable. Complex shapes 
were an even bigger problem (Figure 28a).

Figure 28a   Illustrator’s dashed strokes “the old way.”

Illustrator CS5 fixes this problem with two new icons in the Stroke 
panel (Figure 28b). The first—Preserve Exact Gap and Dash Length—
does exactly what Illustrator has always done. The second—Align Dashes 
to Corners and Path Ends, Adjusting Length to Fit—does what Illustrator 
users have been waiting many versions for: it makes the necessary calcu-
lations to position and adjust all dashes for a much more pleasing result 
(Figure 28c).

Figure 28b  The Align/Adjust dash option selected in the 
Stroke panel.

Creating Better 
Dashed Strokes

#28
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Figure 28c  Adjusted—and much better-looking—dashed strokes in Illustrator CS5.

Illustrator allows for three different dash/gap value combinations for 
any dashed stroke, and the new adjusted strokes work just as well for 
those more complex dashed strokes (Figure 28d). All dash and gap set-
tings between corner points are adjusted accordingly.

Figure 28d  Complex dash combinations also benefit from new Align/Adjust 
behavior.
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#29:  Adding Arrowheads to Strokes

Arrowheads, which were previously effects added to strokes, have been 
moved to a logical home within the revamped Stroke panel. In addition to 
having a new location, arrowheads are now an attribute of the stroke, not 
an effect in a separate dialog box. They’re easier to apply and and modify.

With a path selected, and the Stroke panel open in expanded view 
(Figure 29a), you can select any starting or ending arrowhead from the 
two respective pop-up menus. Each end of the path can have a different 
arrowhead setting. A new “swap” icon in the panel switches the choices 
made for the starting and ending arrowheads, in case the path was drawn 
in a way that Illustrator considers its end point to be what visually looks 
like its start point. In previous versions, you’d have to change each point’s 
arrowhead type in the Add Arrowheads dialog box to accomplish this 
same task.

Swap Starting 
and ending 
arrowheads

Matches scale 
values

Starting arrowhead pull-down menu

Align arrowhead 
to tip of path

Extend 
arrowhead 

beyond end 
of path

Figure 29a  Arrowhead options in the Stroke panel.

The default size of any arrowhead may not be appropriate for your 
stroke, depending on its length and width, so each arrowhead has inde-
pendent Scale options. Previous versions only allowed a single scale value 
for both arrowheads. If you want to preserve that behavior, click the lock 
icon  next to those Scale value fields. That will match the value the of 
both fields to what you enter in either one of them.

Adding Arrowheads 
to Strokes

#29
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Historically, arrowheads extended out past the end points of the 
path. If you wanted your arrowhead tips to be exactly where the path 
ended, you’d have to “cheat” your path back a bit to achieve the proper 
alignment. That’s no longer necessary in Illustrator CS5: the new default 
is for arrowhead tips to align to the start or end point of the path; see  
Figure 29b. If you want your arrowhead tips to extend beyond the end 
points of the path, you can select an optional setting in the Stroke dialog 
box (Figure 29c).

Figure 29b  A path (left) with a normal stroke and 80 percent arrowhead (center) and 
with a variable-width stroke and a 22 percent arrowhead (right). The arrowhead is  
aligned to the end of the path in each instance.

Figure 29c  The same path and stroke options as Figure 29b, but with the arrowheads 
set to extend beyond the end of the path.

All of these enhancements make arrowheads much easier to control, 
align, stylize, and modify without ever leaving the Stroke panel.
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#30:  Drawing with the Shape Builder Tool

Drawing with the 
Shape Builder Tool

#30
Illustrator CS5’s new Shape Builder tool  is like a dynamic version 
of the Pathfinder’s Unite and Minus Front options, combined with Live 
Paint’s shape-sensing, click-and-color functionality. Figure 30a shows 
an illustration at its very early stages, using only primitive shapes as the 
basis for a drawing of a car. No fill or stroke has been applied. Using only 
the Shape Builder tool, we can quickly and easily refine this collection of 
shapes to form the car and simultaneously fill it with appropriate colors.

Figure 30a  An arrangement 
of drawn shapes created as the 
foundation for an illustration of 
a car. The single horizontal line 
defines areas where the shapes 
it intersects can be divided.

The Shape Builder shares a few behaviors with Illustrator’s Live Paint 
feature, including Gap Detection and a Cursor Swatch Preview option that 
applies color as shapes are combined. Double-clicking the Shape Builder 
tool icon in the Tools panel accesses all of these options (Figure 30b).

Figure 30b  The Shape 
Builder Tool Options share 
several features with 
Illustrator’s Live Paint.

Shape Builder vs. 
Pathfinder, Round 1
Pathfiinder’s Minus Front 
function acts on full shapes 
only, subtracting the fore-
ground shape from the 
background shape. How-
ever, Shape Builder can 
“minus” any area created by 
the intersection of paths, 
whether or not they’re com-
plete shapes. This means 
drawing fewer exact shapes 
to get the same results.

Shape Builder vs. 
Pathfinder, Round 2
On speed alone, Shape 
Builder beats Pathfinder 
hands down. To subtract a 
shape with Pathfinder, you 
must select two objects, be 
sure the appropriate sub-
traction shape is stacked 
in front of the artwork you 
want to keep, then use the 
Minus Front option. Depend-
ing on the number of shapes 
you start out with, you 
might need to repeat that 
many times, often making 
copies of certain shapes to 
re-use them in subsequent 
Pathfinder operations.
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To form a car from the collection of shapes in Figure 30a, we start by 
removing parts of any shape that won’t be included in the final illustra-
tion. With all the shapes selected and the Shape Tool (Shift-M) active, you 
need only drag over selected shapes while holding down the Option (Alt) 
key to remove any portion of an object up to the point where it intersects 
with another shape (Figure 30c). Portions of the shapes “sensed” by the 
Shape Builder tool are highlighted as you move over them.

Figure 30c  Three ways to remove portions of shapes with the Shape Builder tool: 
Option-click (Alt-click) and drag through continuous areas (left), Option-click (Alt-click)  
a single area (center), or Shift-Option-click (Shift-Alt-click) and draw a marquee over  
multiple areas (right).

Once the unwanted areas are removed, we can start combining those 
parts we want to keep. With the Cursor Swatch Preview active (Figure 30d), 
you can cycle through document swatches and choose a color to fill the 
remaining shapes with as the Shape Builder combines them (Figures 30e 
and 30f). As with deleting shapes, holding down Shift creates a marquee 
selection, and simply clicking and dragging creates a linear selection of 
continuous shapes.

Figure 30d  The Shape Builder tool with Cursor Swatch Preview active.
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#30:  Drawing with the Shape Builder Tool

Figure 30e  Combining shape 
areas by Shift-dragging to 
create a marquee selection.

Figure 30f  Adding colors to different areas of the artwork as they’re combined with 
the Shape Builder tool.

While much of what the Shape Builder tool does is inherited from 
the Pathfinder and Live Paint features, it works more quickly and more 
intuitively than either of those tools, producing finished illustrations 
(Figure 30g) from basic forms in very little time.

Figure 30g  The finished 
illustration completed entirely 
with the Shape Builder tool.

Shape Builder vs. 
Pathfinder, Round 3
By default, you can use 
Shape Builder to achieve the 
same results as Pathfinder’s 
Unite, Minus Front, Minus 
Back, Intersect, Exclude, and 
Merge functions. But you 
can also mimic Pathfinder’s 
Divide, Trim, Merge, and Crop 
features by turning on Cursor 
Swatch Preview in the Shape 
Builder Tool Options dialog 
box and applying different 
colors to intersecting areas as 
you work with the tool. The 
colors applied define each 
area as a separate shape.

Shape Builder vs. 
Pathfinder, Round 4
Except for the Divide and 
Outline functions, Pathfinder 
works with shapes only, not 
open paths. Shape Builder 
works more like Live Paint 
when artwork contains a 
mix of shapes and paths. The 
Shape Builder tool uses a 
path’s intersection of a shape 
to slice away a portion of 
that shape. Option-clicking 
(Alt-clicking) a segment of 
a path will “trim” that path 
back to the nearest inter-
section point with another 
shape or path.
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Illustrator has a stacking order in each document where, by default, new 
art is created above existing art. To speed up the drawing process, reduce 
the need to re-stack artwork, and eliminate many of the steps involved 
in creating clipping masks, Illustrator CS5 introduces two new draw-
ing modes: Draw Behind and Draw Inside. You can cycle through these 
modes by pressing Shift-D, or you can select any of them from a new icon 
at the bottom of the Tools panel (Figure 31a).

Figure 31a  New drawing mode options 
at the bottom of the Tools panel.

Draw Behind effectively reverses Illustrator’s default behavior by cre-
ating new artwork beneath the existing objects. As you draw or paint in 
this mode, artwork is visible above the other objects in the illustration  
(Figure 31b). However, as soon as you’re done drawing, the new artwork 
is automatically moved back behind all other artwork (Figure 31c).

Figure 31b  While drawing in Draw Behind mode, artwork initially 
appears above other art.

Drawing Behind and 
Drawing Inside

#31
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#31:  Drawing Behind and Drawing Inside

Figure 31c  Finished brush strokes automatically moved behind existing artwork.

Draw Inside mode is available only when a single drawn shape is 
selected. When Draw Inside is activated, the selected artwork is sur-
rounded by a dashed corner selection border (Figure 31d). As long as 
that border is visible, all new artwork will be created inside the shape, 
even when you deselect the shape to start drawing other objects. Draw 
Inside creates clipping masks as you’re working, saving you the trouble of 
doing so after the artwork is completed.

Figure 31d  Draw Inside mode activated for the body of the car.
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An additional benefit of the Draw Inside mode is that allows you to 
paste artwork inside of other artwork. There is no Paste Inside command 
in Illustrator, but when you’re in Draw Inside mode, all pasting is done 
inside the selected object.

Figure 31e  A copied path with a variable-width pattern brush applied 
pasted into the Draw Inside object. Only the parts of the path within the  
shape are visible.

To exit Draw Inside mode, double-click anywhere else on the artboard 
to return to Draw Normal mode.
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#32:  Creating Bristle Brushes

Illustrator CS5 introduces a new kind of brush that’s designed to mimic the 
appearance and behavior of natural media brushes. To do this required 
the addition of a background physics engine that understands a brush’s 
size, shape, length, the number of bristles it contains, and each bristle’s 
thickness and stiffness.

This feature greatly benefits artists using a pressure-sensitive tablet 
and stylus, because the physics engine and brush attributes respond to 
the orientation and tilt of the stylus, and to the pressure applied to it. 
This creates a beautiful “painterly” appearance with what is, in fact, 100 
percent vector-based artwork.

You select a Bristle brush by choosing New Brush, then Bristle Brush to 
open the Brushes panel menu. The Bristle Brush Options dialog box avail-
able in that panel has a Shape pull-down menu for the different categories 
of brushes. There are five brush types—point, blunt, curve, angle, and 
fan—and each has both a flat and round version. Including brush size, 
each of these ten brush types has six customizable attributes (Figure 32a).

Figure 32a  A custom bristle brush established in the Bristle Brush 
Options dialog box. Note that brush names will appear only when the  
Brushes panel is in List View.

There’s a range of settings within each of these attributes, so by mix-
ing and matching brush types and attributes, you have a nearly infinite 
number of brushes at your disposal, faster—and much cheaper!—than 
you could ever have with real paint brushes.

Creating Bristle Brushes
#32 

How Does It Do That?
The Bristle brush mimics the 
effect of actual bristles on a 
surface by creating individ-
ual overlapping filled objects 
for each stroke. If you were 
to expand the appearance of 
a Bristle brush stroke (Object > 
Expand Appearance), you’d 
see each individual bristle 
mark as a filled object.

Bristle Brush 
Attributes Explained
Bristle Length (Short to 
Long). Longer bristles have 
more flexibility as you paint; 
short bristles barely bend.

Bristle Density (Low to 
High). This sets the num-
ber of bristles in the brush 
tip and how close they are 
to one another. Low den-
sity means a lot of space 
between bristles.

Bristle Thickness (Fine 
to Coarse). This refers to 
the thickness of individual 
bristles. In natural media 
brushes, fine would be 
something like a sable hair 
brush and coarse would be 
like a hog’s hair brush.
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Just as Adobe has always respected typographic conventions design-
ers are used to, it now shows that same reverence for traditional brushes 
artists are accustomed to. Illustrator CS5 ships with a Bristle brush library 
(choose Open Brush Library > Bristle Brush > Bristle Brush Library from the 
Brushes panel menu) containing 14 preset brushes based on real-world 
painters’ brushes (Figure 32b).

Angle

Bright

Cat’s Tongue

Dagger

Deerfoot

Dome

Fan

Filbert

Flat

Linear

Mop

Round

Spotter

Stippler

Figure 32b  Samples of each brush in Illustrator’s Bristle 
Brush Library. All strokes are the same weight. Their  
appearance is affected by brush thickness and other  
brush-specific attributes.

The Bristle brush paints using the path’s stroke color, not its fill. You 
can either paint with the Brush tool, or select existing paths and apply 
a Bristle brush to them from the Brushes panel. Every brush stroke is a 
fully editable vector path. You can move and modify anchor points and 
Bezier curves as you would with any drawn path and still preserve the 
brush stroke appearance.

If you’re using a pressure-sensitive tablet and stylus with the Bristle 
brush tool, a cursor preview on the tool simulates the appearance and 
angle of the brush tip, matching the orientation and tilt of the stylus as 
you move and tilt it (Figure 32c).

Figure 32c  A Brush tool cursor preview—specific to the current 
position and angle of a drawing stylus—is displayed when 
working with a pressure-sensitive tablet and stylus.

Paint Opacity (Translucent to 
Opaque). In digital painting—
unlike real painting—you 
use the brush to control paint 
transparency. The less opaque 
the paint, the more shows 
through it as you paint. Semi-
transparent strokes are akin 
to the look of watercolors or 
transparent acrylics.

Stiffness (Flexible to Rigid). 
This refers to how much the 
bristles bend. Flexible bristles 
bend more and are softer. 
Rigid bristles produce hard, 
discernible bristle patterns.

Change Your Brush on 
the Fly
Don’t worry too much about 
defining the size of your 
brush when creating a new 
Bristle Brush. Instead, set the 
size based on either (a) how 
well the preview in the Bristle 
Brush Options dialog shows 
you the brush appearance, 
or (b) the size you expect to 
use most often in your art-
work. The brush size can be 
increased on the fly by hit-
ting the right square bracket 
key, or decreased with the 
left square bracket key.

(continued on next page)
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#32:  Creating Bristle Brushes

A related keyboard short-
cut increases or decreases 
the paint opacity. Hit the 1 
key for 10% opacity, 2 for 
20% and so on up to 90%. 
Hit 0 for 100% opaque paint 
coverage.

Previewing a Bristle 
Brush in Color
The Bristle brush and the 
Brush panel are limited 
to grayscale displays of a 
brush’s appearance. To pre-
view what a Bristle brush 
effect will look like in color, 
select a path and apply a 
stroke color and weight. 
Then, either apply an exist-
ing brush to that stroke, or 
define a new brush with the 
Preview check box selected 
in the Bristle Brush Options 
dialog.

Performance and Printing
The Bristle brush’s creative potential is limited only by your imagination. 
But what about more practical considerations like system performance and 
printing? The more bristles you have in a brush, the more complex it is, and 
all that beautiful overlapping transparency comes at a price.

Complex brushwork can potentially cause rendering speed and printing 
issues. If you plan to use the Bristle brush, Adobe recommends 4GB of RAM 
(well above the 1GB minimum requirement), and the fastest available pro-
cessor for optimum Illustrator performance.

Even with gigabytes of RAM and a killer processor, you’ll see a warning dia-
log about the amount of transparency in your file when you try to save it to 
EPS, PDF, or any other format that requires flattening.

When your artwork’s final, make a copy of the file and rasterize complex 
Bristle brush artwork in that copy in Illustrator (Object > Rasterize) before 
placing it in InDesign or into a Postscript process that requires flattening for 
output. This will avoid PDF or RIP rasterization, which is much slower.
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The multiple artboard feature introduced in Illustrator CS4 enabled 
designers to collect many Illustrator assets and layouts into a single file, 
stored on independent artboards (Figure 33a). The presentation and 
organizational benefits of multiple artboards were a big hit, and Illustrator 
CS5 builds upon the feature to make it more versatile and powerful.

Figure 33a  A multi-artboard Illustrator CS5 document 
containing various components of a design project: poster,  
flyer, postcard, CD booklet, and disc label.

Artboards now have their own dedicated panel (Window > Artboards) 
from which you can select, rename, and reorder your artboards (Figure 33b). 
Clicking any artboard name in the Artboard panel makes it the active art-
board, and double-clicking fills your document window with that artboard.

Figure 33b  Illustrator CS5’s new Artboards panel displaying six artboards and the 
panel’s menu options.

Using Multiple Artboards
#33

Rulers Done Right
Illustrator CS5 fixes two 
pesky ruler problems. First, 
the 0,0 origin point for art-
boards is now at the  
top-left corner of the 
artboard, instead of the 
bottom-left. Second, Illustra-
tor CS5 now supports both 
a global ruler for the entire 
Illustrator document, and 
rulers for each artboard. This 
per-artboard ruler behavior 
is the new default, so you’ll 
notice that the 0,0 origin 
point snaps to the top left of 
the active artboard as you 
switch between artboards. 
To restore the previous docu-
ment-wide Illustrator behav-
ior, choose View > Rulers > 
Change to Global Ruler.
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#33:  Using Multiple Artboards

When you create a new document, you can add multiple artboards of 
identical size in the New Document dialog box. In an existing document, 
you can use the Artboard tool  to add artboards of varying sizes at 
any time. A single Illustrator document can contain up to 100 artboards.

With the Artboard tool, you can select entire artboards, resize them 
by pulling on any of the corner/edge handles, or reposition them on 
the Illustrator canvas by clicking and dragging (Figure 33c). For precise 
control over artboard size, use the width and height fields in the Control 
panel to specify the artboard’s size, and the x and y coordinates to control 
its position on the Illustrator canvas.

Figure 33c  Resizing (left) and repositioning (right) artboards with the Artboard tool.

By default, everything on the artboard moves with it, except locked 
objects and objects on locked layers. However, artwork doesn’t scale 
when the artboard is resized. To move the artboard without moving the 
art on it, deselect the Move/Copy Artwork with Artboard button  in 
the Control panel.

Same Button, 
Different Behavior
The Artboard panel and the 
Control panel each have a 
New Artboard button, but 
they behave a bit differently. 
Both will create a new art-
board at the size of the cur-
rently active artboard, but 
that’s where they part com-
pany. When you use the Art-
board panel to create a new 
artboard, it’s added at the far 
right of the canvas, aligned 
with the top of the topmost 
artboard in your document. 
The Control panel, however, 
leaves artboard placement 
up to you. When you click 
the New Artboard button 
from the Control panel, your 
cursor gets “loaded” with an 
artboard and wherever you 
click is where that artboard 
gets dropped on the canvas.
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In CS4, artboards were identified only by a number, making it hard 
to keep track of what each artboard contained when selecting, printing, 
or exporting individual artboards. In CS5, artboards can be given names 
that are displayed in the Control panel (when the Artboard tool is in use), 
the Artboard Navigation pop-up menu (Figure 33d), or in the Artboard 
panel.

Figure 33d  Artboards listed in 
the Artboard Navigation menu.

The fastest way to name artboards is not from the Artboards panel, 
however. That process requires selecting the artboard name, choosing 
Artboard Options from the panel menu, renaming the artboard in a dia-
log box, then clicking OK. It’s much more efficient to switch to the Art-
board tool (Shift-O), select the artboard to be renamed, and enter a name 
in the Name field of the Control panel. While that tool’s still active, you can 
select other artboards and quickly rename them as well.

Rearranging artboards in the Artboard panel does not rearrange them 
visually, just hierarchically. The Artboard panel sequence and appear-
ance of artboards on the Illustrator canvas are not dynamically related. 
To arrange your artboards on the canvas so they reflect the order in the 
Artboard panel, choose Rearrange Artboards from the Artboard panel 
menu, and specify your desired arrangement options (normal order or 
reverse order, horizontal or vertical distribution, number of columns, and 
spacing between artboards) in the dialog box (Figure 33e).

Lose the Board, Keep 
the Art
When you delete a page in 
InDesign, everything on it is 
also deleted. But that’s not 
the case with artboards in 
Illustrator. Deleting an art-
board—by clicking the trash 
can icon in the Control or 
Artboard panels—deletes 
the artboard, but the art 
itself is preserved in place.

Controlling Artboard 
Sizes
You can quickly draw out 
new artboards with the Art-
board tool by clicking and 
dragging out an area. When 
you have Smart Guides 
turned on (the default), a 
measurement cursor dis-
plays the current size of the 
drawn artboard. To get more 
precise control over the art-
board size and its position 
on the page, either enter 
the size and position values 
directly in the Control panel, 
or click the Artboard Options 
button to define your art-
board’s parameters in the 
Artboard Options dialog.
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#33:  Using Multiple Artboards

Figure 33e  Artboards rearranged in a single row by using the Rearrange Artboards 
dialog box.

Whether or not you rearrange your artboards visually, their sequence 
in the Artboards panel plays a key role when the document is printed or 
exported. The numeric order of artboards in the panel acts as the docu-
ment’s page order when printing and saving as a PDF.

Other print- and export-related artboard improvements include:

•	 A new Auto-Rotate default in the Print dialog box sets all artboards to 
the proper orientation for the destination page size, allowing you to 
print portrait- and landscape-oriented artboards simultaneously.

•	 You can now save native Illustrator (.ai) files from individual artboards 
using Save As. This allows you to save a multi-artboard file as separate 
files in Illustrator CS3 (or earlier) format for backward compatibility.

•	 When exporting to non-native formats (EPS, JPEG, and so on), select 
the Use Artboards check box in the export dialog to create separate 
files from each artboard. A “root” name is required for the exported 
files (i.e., campaign.jpg), but the files are named with their art-
board name or number appended after that shared root name (i.e.,  
campaign_postcard.jpg).

Cut, Don’t Copy, When 
Using Paste on All 
Artboards
Two new artboard-centric 
options—Paste in Place and 
Paste on All Artboards—
have been added to Illustra-
tor CS5’s Edit menu. Paste in 
Place pastes anything cop-
ied to the clipboard at the 
exact same x, y coordinates 
from which it was copied. 
Paste on All Artboards does 
the same thing on every 
artboard in the document 
at once.

When using Paste on All Art-
boards to copy artwork from 
one artboard onto all oth-
ers, remember to use the Cut 
command, not Copy. Paste 
on All Artboards includes 
the current artboard, so it 
will make a duplicate of the 
copied artwork on the same 
artboard while adding art to 
the others. Using Cut avoids 
this problem.
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The Power of Appearances
#34

One of Illustrator’s most powerful and underutilized features isn’t really 
a feature, it’s a panel: the Appearance panel (Window > Appearance or 
Shift-F6). Many designers may know it’s there and have perhaps used 
it from time to time, but few understand its full scope or exploit its 
potential…largely because Adobe has never given it the hype it deserves.

Understanding Appearances
Paths and anchor points have no appearance. They define shapes, or lines, 
but contain no information about how that shape or line looks. Paths 
are like skeletons, and appearances are the attributes that flesh out the 
skeleton, giving it recognizable form (Figure 34a). All attributes applied 
to an object—fill, stroke, effects, opacity, etc.—make up its appearance.

Paths

Appearances

Figure 34a  A series of paths (top) as seen on the Illustrator artboard vs. those same 
paths with appearances applied to them (bottom).

Three Basic Types of 
Appearances
Fills: Fill the enclosed area 
of the path (solid, gradient, 
pattern)

Strokes: Are applied directly 
to the drawn path (solid, 
dashed, brushes, etc.)

Live Effects: Adapt to 
changes made to the path 
(drop shadows, rounded cor-
ners, 3D, etc.)
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#34:  The Power of Appearances

The Appearance panel is a direct conduit to all appearance settings for 
an object. It also shows you all the appearance attributes of a document, 
and reveals the stacking order of all appearances applied to a selected 
path or object at a glance. This one panel gives you one-click access to 
the panels and dialog boxes for any fill, stroke, opacity settings, and live 
effects that are part of an object’s appearance (Figure 34b).

Click to edit 
effect

Click to access Swatches panel 
(Shift-click to access Colors panel)

Click to access all 
Stroke panel options

Click to modify 
stroke weight

Add multiple fills 
and/or strokes

Front

Back

Stacking 
order

Drag any attribute up or down 
to change its stacking order on 
the selected object.

Figure 34b  The Appearance panel and its options at a glance.

Selecting vs. Targeting
Paths get selected, but 
appearances are targeted. 
When you select a path, 
you’re selecting the entire 
object. Illustrator does 
basic appearance target-
ing for you at this level (fill 
and stroke only), so you can 
change basic appearance 
attributes.

If an object has more than 
one stroke, simply select-
ing the object targets its 
topmost stroke only. Target-
ing any stroke below that 
requires clicking the spe-
cific attribute name in the 
Appearance panel.

Targeting an appearance 
attribute allows you to work 
exclusively on that attri-
bute, not the entire selected 
object. A targeted attribute 
can also be moved up and 
down in the Appearance 
panel to change its posi-
tion in the stacking order for 
selected object, just as you 
drag items up or down in 
the Layers panel to change 
the stacking order for a 
document.
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Adding Multiple Fills or Strokes
Illustrator creates all artwork with what’s called a “basic” appearance, 
meaning one stroke, one fill, and no effects. But you can achieve a “com-
plex” appearance for any object, ranging from one or more effects to mul-
tiple fills and strokes (Figure 34c).

Figure 34c  The guitar illustration has complex appearances applied but uses no 
more paths than the simple version in Figure 34a. The body of the guitar (left 
Appearance panel) has two fills—a solid color and a pattern fill (with a 50% overlay  
blend mode) above it in the stacking order. Both the body and the neck (right  
Appearance panel) have two strokes—a thin white stroke stacked above a wider  
black one—and a drop shadow. The frets along the neck are individual 
paths, each with two strokes applied via the Appearance panel.
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Saving Appearances as Graphic Styles
Once established, any appearance can be saved as a Graphic Style 
(Window > Graphic Styles or Shift-F5) that applies all appearance attri-
butes saved within it in a single click. A change to the style changes every 
object in the illustration to which that style has been applied.

To create a Graphic Style from an appearance, select an object with 
the desired appearance, then drag the small thumbnail of the appearance 
next to the object name (Path, Compound Path, etc.) into the Graphic 
Styles panel (Figure 34d). You can double-click its thumbnail in the 
Graphic Styles panel to give it a useful name. Once defined, that style can 
be applied to any other object with a single click on the style thumbnail.

Figure 34d  Creating a Graphic Style from a specific appearance is as easy as clicking 
the Appearance thumbnail (right) and dragging it into the Graphic Styles panel (left).

Assigning Appearances to Layers
Appearances can be applied to an entire layer, so that all art drawn on or 
moved to that layer automatically has that appearance. This can be an 
enormous time-saver in complex, layered illustrations like maps, where 
common appearances (i.e., road lines) are applied to many objects.

To assign an appearance to a layer, select any object that uses the 
desired appearance and locate it in the Layers panel by expanding the 
disclosure triangle for the layer it’s on. The selected object will have 
a solid colored square next to its name, and you’ll see a small gradient 
circle indicating that a complex appearance is applied (Figure 34e). 
Option-click (Alt-click) the gradient circle, drag it up to another layer in 
the panel, then release the mouse. You’ll see a gradient circle applied at 
the layer level in the panel for that layer (Figure 34f).

Choosing Complexity
When you draw an object in 
Illustrator, it uses the appear-
ance of the last object you 
selected, but only up to a 
point. New art in Illustrator 
uses only a basic appear-
ance—one fill, one stroke, 
no effects. The same is true 
for the Eyedropper tool. 
If you sample a complex 
appearance with the eye-
dropper, only its basic com-
ponents—the topmost fill 
and stroke—are picked up.

To change this behavior for 
drawing, go to the Appear-
ance panel menu and 
deselect New Art Has Basic 
Appearance. To change it 
for the Eyedropper tool, 
double-click that tool and, 
in the resulting dialog box, 
select the Appearance check 
box in both the “Eyedropper 
Picks Up” and “Eyedropper 
Applies” columns.

Making these changes in an 
open document sets that 
behavior for that document 
only. To make those changes 
application-wide, follow 
the same steps with no 
documents open.

#34:  The Power of Appearances
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Figure 34e  A selected object (with square at far  right) in the Layers panel. 
The gradient circle indicates that a complex appearance is applied, and 
the circle around that indicates that the appearance is targeted. The path 
above it has a hollow circle, indicating only basic appearance in use. The 
path below it also has a complex appearance, but it is not targeted.

Figure 34f  A layer with a 
complex appearance assigned to 
it, indicated by the gradient circle 
at the layer level in the panel.

Note that once the appearance applies to the layer, the objects on that 
layer do not need to have any appearance applied to them. The layer han-
dles all of that (Figure 34g). Any appearance attributes applied directly 
to an object on that layer will be added to the layer-level appearance. 
Also, as soon as you move an object off of that layer, the object loses all 
layer-based appearance attributes.

Figure 34g  An object with 100 percent layer-based 
appearance applied. Note that all appearance attributes in the  
panel are attached to the layer. The only attribute under 
“Contents” is a default opacity setting.

Redefining Graphic 
Styles
Unlike InDesign’s Object 
Styles, you don’t make 
changes to Illustrator’s 
Graphic Styles from the 
Graphic Styles panel. 
Instead, you make your 
changes to a selected object 
via the Appearance panel, 
then choose Redefine Style 
from the panel menu. This 
updates the Graphic Style to 
match the appearance of the 
current selection, and every 
other object to which that 
style is applied will reflect 
those changes.

C H A P T E R  f o u r 	 Working with Illustrator
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#35:  Creating Crisp Artwork for the Web

Creating Crisp Artwork 
for the Web

#35
With its strong typographic capabilities, fast and flexible drawing capa-
bilities, and tight integration with Flash CS5 Professional, Illustrator is a 
great tool for Web graphics creation. Since it started as a resolution-inde-
pendent application for print, however, there are some things you need 
to know to properly work with Illustrator to create artwork for the Web.

Even though all artwork appears razor-sharp at any magnification in 
Illustrator, the same is not true when that art is rasterized (converted from 
vectors to pixels) for the Web. Artwork gets fuzzy when exported for the 
Web due to anti-aliasing, which blurs edges to smooth the appearance to 
the naked eye (Figure 35a). Illustrator CS5 includes a new Pixel Preview 
(View > Pixel Preview) mode that allows you to see just what your artwork 
will look like when rasterized.

Figure 35a  Artwork as it normally appears in Illustrator (top) and the same artwork 
after it’s been rasterized (bottom).

But seeing a problem with rasterization isn’t much help if you can’t 
fix it. Fortunately, there are new Illustrator features for that, too. The first 
is the Align to Pixel Grid option, which is available either for individual 
objects (Figure 35b), or on a document-wide basis. To align one or more 
objects to the pixel grid, select the objects, open the Transform panel 
(Window > Transform), and select the Align to Pixel Grid check box. To 
make this behavior persistent throughout your document, choose Align 
New Objects to Pixel Grid from the Transform panel menu.

Figure 35b  The same rasterized buttons from Figure 35a aligned to the 
pixel grid. Notice the improvements around the edges of each button.

The Pixel Grid
When you zoom above 500 
percent in Photoshop, the 
pixel grid becomes visible. In 
Illustrator, however, the pixel 
grid doesn’t appear until you 
zoom to 600 percent. If you 
prefer to disable the pixel 
grid, deselect the Show Pixel 
Grid check box in the Grids 
& Guides area of Illustrator’s 
Preferences dialog.

Automate Your 
Alignment
When you save artwork as a 
symbol, you’ll see an “Align 
to Pixel Grid” option in the 
Symbol Options dialog box. 
Every time a symbol with 
Align to Pixel Grid enabled 
is placed, it will automati-
cally snap to the pixel grid. If 
you know before you create 
a document that your desti-
nation is the Web, and you’ll 
want all art aligned to the 
pixel grid, select the Align 
New Objects to Pixel Grid 
option in the New Docu-
ment dialog box.
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Aligning artwork to the pixel grid solves your rasterization problems 
for drawn shapes, but typography requires extra attention. The Charac-
ter panel (Window > Type > Character) in Illustrator CS5 now includes 
the same type anti-aliasing options that Photoshop has had for many 
versions (Figure 35c). Choosing the correct option will depend entirely 
on the typeface in use and its size, color, and interaction with the colors 
around it.

None
Sharp
Crisp

Strong

Figure 35c  Anti-aliasing options in the fully expanded Character 
panel (left) and the results of each setting (right).

Getting Pixel 
Dimensions You  
Can Trust
When you select an object 
with a stroke applied to it in 
Illustrator, the Control panel 
displays the height and width 
for the path used to draw 
that object, not for the full 
extent of the stroke applied 
to that path (meaning the 
thickness beyond the path 
edge). Illustrator strokes, by 
default, are distributed along 
both sides of the path. This 
means you won’t get accu-
rate pixel dimensions for 
stroked artwork, since strokes 
add pixels to an object’s over-
all size.

When you’re working in a 
document that’s intended 
for the Web, you can com-
pensate for this discrepancy 
by changing a preference. 
In the General options of 
Illustrator’s Preferences dia-
log, select the Use Preview 
Bounds check box to force 
all dimensions displayed for 
an object to include its out-
ermost boundaries, not just 
the extent of its path.
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#36:  Preparing Scalable Web and Print Graphics

Preparing Scalable Web 
and Print Graphics

#36
A long-standing frustration about creating Illustrator graphics was how 
objects distorted when scaled. Everything looked fine when an object 
was scaled in the same proportion, but if it was scaled more in one direc-
tion than another, rounded corners became stretched and horizontal and 
vertical stroke weights became inconsistent (Figure 36a).

Figure 36a  When Illustrator artwork (left) is scaled in one direction only (right) the 
corner shapes are distorted, and the horizontal and vertical stroke weights become  
inconsistent.

For several versions, Illustrator has supported 9-Slice Scaling—an 
intelligent object scaling method used by Flash. Symbols created in Illus-
trator and destined for Flash could have 9-Slice Scaling guides established 
in Illustrator before they were exported (Figure 36b). Until Illustrator CS5, 
however, this kind of scaling worked only after the art was exported to 
Flash. Illustrator itself could not take advantage of the feature. Now you 
have the benefit of the same kind of intelligent scaling Flash has sup-
ported for all Illustrator artwork, whether destined for print or the Web.

Figure 36b  Enabling 9-Slice Scaling when creating a symbol allows for 
intelligent object scaling in both Illustrator CS5 and Flash CS5 Professional.
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What 9-Slice Scaling does is establish four guides (two horizontal and 
two vertical) on the symbol, dividing it into nine regions (Figure 36c). 
You can position the guides so that rounded or other stylized corners 
are “locked off” from scaling. The top and bottom center regions scale 
horizontally, and the left and right center regions scale vertically. Only 
the center region scales in both directions. When the object is scaled dis-
proportionally, stroke weights remain consistent and custom corners are 
unchanged (Figure 35c).

Locked against 
any scaling

Locked against 
any scaling

Only scales 
horizontally

Only scales 
horizontally

Only scales 
vertically

Locked against 
any scaling

Locked against 
any scaling

Scales both horizontally 
and vertically

Only scales 
vertically

Figure 36c  The four scaling guides divide an object into 
nine regions, each with its own scaling behavior.

Figure 36d  Symbols with 9-Slice Scaling enabled maintain a consistent 
stroke weight and keep the four corner regions consistent with the original 
symbol’s shape (left), even when scaled in only one direction (right).

Any Way You Slice It
Illustrator CS5 has improved 
another kind of slice 
behavior to make your 
Web workflow more effi-
cient. Artwork created in 
Illustrator that has been 
sliced for eventual use in a 
Web layout (Object > Slice), 
is much easier to selectively 
export with the addition 
of the Slice Selection tool 

 , which shares a spot 
in the Tools panel with the 
Slice tool. Defined slices can 
be selected and more eas-
ily exported with the new 
Save Selected Slices com-
mand (File > Save Selected 
Slices…) without having 
to export the entire layout. 
You can even have Illustrator 
generate the HTML neces-
sary for the selected slices.
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ASE (Adobe Swatch 
Exchange), 283–284

ASE swatches, importing, 284
Asynchronous JavaScript and 

XML (Ajax), 188
audio, importing into Flash 

Catalyst, 231
Austrian church, 39–40
Auto-Fit, using with Gap tool, 

140–141
automating

Illustrator with actions, 
298–300

Photoshop with actions, 
298–300

B
backgrounds, accentuating 

flat colors in, 71
barrel distortion, fixing in 

Camera Raw, 78
beta software, source for, 13

AIR applications, publishing, 
270–271

Ajax (Asynchronous JavaScript 
and XML), 188

Alt key. See keyboard 
shortcuts

analytics, 326
Animation Encyclopedia, 155
animation for Web, creating in 

InDesign, 151–155
animations, adding to 

symbols, 260–262. See also 
Inverse Kinematics

appearances. See also 
Illustrator
assigning to layers, 

121–122
basic, 120
fills, 118
live effects, 118
on paths, 118
saving as Graphic  

Styles, 121
strokes, 118
targeting, 119
using in Illustrator,  

118–122
Apple devices, displaying 

pages on, 212
Application Frame, using in 

Photoshop, 67
Application Manager, 

launching, 20
arrowheads, adding to strokes, 

103–104
artboard sizes, controlling, 116
Artboard tool, 115–116
artboards

0,0 origin point for, 114
creating, 115
deleting, 116
exporting, 117
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captions, live vs. static, 276
car, forming from shapes, 

106–107
Cascading Style Sheets (CSS), 

173, 183–185
cast shadow, simulating, 97
Catalyst. See also Design 

workspace
adding sound, 230–232
adding transition  

effects, 238
adding video, 230–232
Align to Pixel Grid, 221
On Application Start 

interaction, 237
button interaction, 

236–237
Code workspace, 218
components, 215, 233
converting wireframes to 

components, 235
creating components, 

233–235
creating interactions, 

236–237
creating scrollbar, 233–234
Design workspace, 216–217
drag-and-drop 

components, 214
easing styles for 

transitions, 241
editing components  

in, 234
editing vector images, 

227–228
Edit-in-Place mode, 234
features of, 214–215
Fidelity options for 

Illustrator, 222
font embedding, 243
Illustrator Import options, 

222–224

button actions, capabilities 
of, 149

button events, 149
button interaction, creating in 

Flash Catalyst, 236–237
Button panel

Actions option, 149
Event option, 149
opening in InDesign, 148
On Release event, 149

buttons, attributes in 
InDesign, 148

Buzzword service, 17,  
316–317

C
Camera Raw

adjusting settings for, 25
Basic panel, 78–79
Camera Calibration panel, 

78, 81
Camera Profile, 78
Detail panel, 72, 78–79
Effects panel, 78, 80
fixing Distortion in, 78
fixing parallax distortion, 78
history of, 77
HSL/Grayscale panel, 78, 80
image sharpening in, 74
Manual Lens Corrections, 78
noise reduction in, 74
opening images in, 25
opening JPEGs in, 34
opening raw images in, 24
opening TIFFs in, 34
reducing image noise in, 72
using in Bridge, 24–25
using to edit raw images, 

77–81
Caption Setup dialog box, 

using in InDesign, 276

synchronizing color 
settings from, 2–4

Bristle brushes. See also 
brushes
changing on fly, 112–113
creating in Illustrator, 

111–113
cursor preview, 112
density of, 111
length of, 111
Library, 112
paint opacity, 112–113
previewing in color, 113
printing, 113
Rasterize option, 113
resizing, 112
stiffness, 112
system performance, 113
thickness of, 111
using in Photoshop, 55–60

browser support,  
determining, 206

BrowserLab, 17
delaying screen  

shots, 182
keyboard shortcuts, 182
saving screen shots, 182
using with Dreamweaver, 

179–182
brush color, changing in 

Photoshop, 58–59
brush hardness, changing in 

Photoshop, 59–60
brush sizes, changing in 

Photoshop, 59–60
brush tool, accessing in 

Photoshop, 56
brushes, creating in 

Photoshop, 57. See Bristle 
brushes; Mixer brushes

business card master pages, 
creating in InDesign, 131
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activating screen  
sharing, 324

annotating screens, 325
Annotation toolbar, 325
managing attendees, 325
maximum number of 

people for, 324
minimizing panel, 325
Share My Screen  

feature, 323
contact sheets, creating with 

Bridge, 312–313
Content Grabber, using in 

InDesign, 137–138
content management 

system (CMS), using with 
Dreamweaver, 194

Content-Aware Fill
using in Photoshop, 36–41
using with Spot Healing 

Brush tool, 39
Corner effects, using in 

InDesign, 144–145. See also 
rounded corners

CS Live services
accessing, 319
Acrobat.com, 17, 323
Adobe CS Review, 17, 

318–322 
Adobe Story, 17
availability of, 319
BrowserLab, 17, 179–182
Buzzword, 17, 316–317
ConnectNow, 323–325
SiteCatalyst NetAverages, 

17, 326–331
CS Review service

adding comments to, 321
inviting client 

participation, 320
jumping to comments, 322
naming, 318

creating, 263
deleting, 264
importing as XML, 264
using in Flash Professional, 

263–264
Code view

opening in HTML5 starter 
layouts, 202–203

using in Dreamweaver, 194
Code workspace in Catalyst, 218
codecs

AAC (Advanced Audio 
Coding), 231

H.264, 230
MP3, 231
On2 VP6, 230
Sorenson Spark, 230

color combinations,  
Kuler, 14–16

color management, 2–3
color settings, synchronizing, 

2–5
color swatches

exporting, 283–284
sharing, 283–284

colors, adding in Photoshop, 58
comb fields, including on 

forms, 281–282
Command key. See keyboard 

shortcuts
commands, playing, 300
components

converting artwork to, 
233–234

converting wireframes  
to, 235

editing in Flash Catalyst, 234
skinning, 235

compression formats, 157
Concepción, Anne-Marie, 303
Configurator, 13
ConnectNow service, 323–325

Catalyst (continued)
pages, 215
Photoshop Import 

Options, 225–226
planning projects, 219
publishing projects, 243
repeating effects, 242
round-trip editing, 

227–229
skinning components, 235
Smooth Transition Options 

panel, 239–240
starting in Illustrator, 

220–224
starting in Photoshop, 

225–226
states, 215
testing scrollbar, 234
Timeline panel, 238
Transform panel, 221
transitions, 215, 239–242
wireframe components, 

215, 233, 235
Chalk & Charcoal filter, 62
Character panel, anti-aliasing 

options in, 124
check boxes, including on 

forms, 280
Click appearance, adding to 

buttons, 148
Clone Stamp tool, using in 

Photoshop, 40–41
CMS (content management 

system), using with 
Dreamweaver, 194

CMS frameworks, 196, 200
CMYK working space,  

picking, 3
code. See Live Code
code hinting. See PHP code 

hinting
code snippets
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enlarging Code View font, 9
Exchange, 13
filtering files, 196
FTP connection, 171
hovering with mouse, 184
HTML5, 202–207
Image Preview dialog  

box, 285
Inspect feature, 183–185
Kuler support for, 16
linking Photoshop images 

to, 285–287
liquid versus fixed layouts, 

174–175
Live Code, 183,  

186–187, 196
Live View, 183–187,  

195–196, 211
loading PHP pages, 195
media queries, 210
Multiscreen Preview, 

208–212
PHP code hinting, 197–201
remote vs. testing servers, 

171–172
revealing files on Web 

servers, 194–196
rounded corners, 205–207
setting preferences in, 9
setting up test server, 194
shadows, 205–207
site layouts, 184–185
Site Setup dialog, 170–172
Split view, 195
starter layouts, 173–175
templates, 175
testing designs, 179–182
troubleshooting designs, 

183–186
using CMS (content 

management system) 
with, 194

Design-Time Data  
panel, 217

interactions, 216
Pages/States panel, 216
panels in, 216–217
Timeline panel, 217

devices, displaying pages on, 
209–212

Distortion, fixing in Camera 
Raw, 78

Draw Behind mode, using in 
Illustrator, 108–110

Draw Inside mode, using in 
Illustrator, 108–110

drawing in perspective, 93–97
Dreamweaver

adding closing tags (>), 204
adding servers for Web 

sites, 171
alternate designs, 208–212
alternate screen layouts, 211
automating file  

discovery, 195
BrowserLab, 179–182
browsing Web with, 

186–187
changing page layouts for 

devices, 208–212
code hinting, 197–201
Code view, 194–195
CSS Enable/Disable, 

176–178
CSS Inspect, 183–186
CSS3, 202–207
default images folder, 170
delaying screen shots, 182
Design view, 176,  

194–196, 211
determining browser 

support, 206
dynamic files on Web 

servers, 194–196

replying to comments, 322
Share dialog box,  

320–321
Upload Settings dialog 

box, 318
CS5 features, getting 

information about, 11
CSS (Cascading Style Sheets), 

173, 183–185
CSS Enable/Disable, using in 

Dreamweaver, 176–178, 
207

CSS files, using with starter 
layouts, 173–174

CSS Inspect, 183–185
CSS3

border-radius property, 
205–206

defining rounded corners, 
205–207

media queries, 208, 
211–212

using in Dreamweaver, 
202–207

Ctrl key. See keyboard 
shortcuts

D
Deco tool

drawing effects, 256
Tree Brush effect, 256
using with Flash 

Professional, 256–257
deleting

artboards, 116
code snippets, 264

Design view, using in 
Dreamweaver, 194–196, 211

Design workspace. See also 
Flash Catalyst
artboard area, 216
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fireplace illustration, 98, 100
FLA files

ActionScript in, 158
exporting to FLA, 158
interactive features in, 158

Flash Catalyst. See also Design 
workspace
adding sound, 230–232
adding transition  

effects, 238
adding video, 230–232
Align to Pixel Grid, 221
On Application Start 

interaction, 237
button interaction, 

236–237
Code workspace, 218
components, 215, 233
converting wireframes to 

components, 235
creating components, 

233–235
creating interactions, 

236–237
creating scrollbar, 233–234
Design workspace, 

216–217
drag-and-drop 

components, 214
easing styles for 

transitions, 241
editing components in, 234
editing vector images, 

227–228
Edit-in-Place mode, 234
features of, 214–215
Fidelity options for 

Illustrator, 222
font embedding, 243
Illustrator Import options, 

222–224
pages, 215

TOC style, 166–167
XHTML format, 166

Exchange, 12
for Dreamweaver, 13
for Flash, 13
for Illustrator, 13
for InDesign, 13
for Photoshop, 13
widgets on, 189

exporting. See also 
importing
to FLA from InDesign, 158
HTML files from  

InDesign, 157
interactive PDF with video, 

159–162
to SWF from InDesign, 

156–157
extensions, downloading, 12–13
Eyedropper tool, changing 

behavior of, 121

F
Fidelity options

Blend, 223
Filters, 222
Gradients, 223
Text, 222

files, opening, 25. See also 
linked files

Fill dialog box, opening in 
Photoshop, 37–38

fills
adding in Illustrator, 120
as appearances, 118

filters. See also Photoshop 
filters; Smart Filters
Chalk & Charcoal, 62
Lens Correction, 75–76

final render process, using 
with Photoshop filters, 69

Dreamweaver (continued)
WebKit layout engine, 186
Widget Browser, 188–193
workspace button in, 10

droplets, defined, 298
DTBook format, using with 

EPUB, 166

E
easing styles

Bounce, 241
Elastic, 241
Linear, 241
Power, 241
Sine, 241
using with transitions, 241

eBooks. See EPUB
effects, repeating in Flash 

Catalyst, 242
Elastic easing style, 241
email addresses, using as 

watermarks, 30
encoding for Flash Catalyst, 230
envelope master pages, 

creating in InDesign, 131
EPUB

adding metadata, 164
CSS files, 163, 166
DTBook format, 166
export options, 164–167
exporting for, 163–167
handling covers, 163
inserting pages, 163
organizing sections, 166
preparing documents for, 

163–164
setting JPEG options, 165
specifying InDesign 

styles, 163
splitting documents, 163
table of contents, 164
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Create Gallery drawer, 311
creating in Bridge, 309–311
entering descriptions  

for, 310
Output drawer, 309–310
Save Style icon, 311
Site drawer, 310
uploading, 311

Flex framework, 218
FLV video, support for, 160
FLVPlayback component, 266
fonts

embedding in Flash 
Professional, 253

resizing in Photoshop, 6
forms

check boxes, 280
comb fields, 281–282
fill-in lines, 278–279
radio buttons, 280–281
signing in Acrobat 

Professional, 306–308
using custom stamps with, 

306–308
Fruit brush, creating in 

Photoshop, 57
FTP connection, using with 

Dreamweaver, 171
FXG files

exporting, 250–251
importing, 250–251
using with Illustrator files, 

224
.fxp extension, explained, 215

G
galleries. See Web galleries
Graphic Styles

managing, 122
saving appearances as, 121

importing FXG files, 
250–251

importing Illustrator  
files, 246–248

importing Photoshop files, 
246–248

importing Photoshop 
layers to, 248

Inverse Kinematics, 258–259
layers accepted by, 294
motion presets, 260–262
movie clips, 295
versus Photoshop, 296
playing video, 265–267
preserving Photoshop 

layers in, 294–296
preserving Photoshop 

styles in, 294–296
publishing AIR 

applications, 270–271
publishing projects, 

268–269
round-trip editing, 249
Spring settings, 258
TLF (Text Layout Format), 

252–253
type composition options, 

254–255
using publishing  

profiles, 269
Video Import Wizard, 266

Flash Professional files
ActionScript in, 158
exporting to FLA, 158
interactive features  

in, 158
Flash projects, publishing, 

268–269
Flash Web galleries

Appearance drawer, 310
Color Palette drawer, 

310–311

Photoshop Import 
Options, 225–226

planning projects, 219
publishing projects, 243
repeating effects, 242
round-trip editing, 

227–229
skinning components, 235
Smooth Transition Options 

panel, 239–240
starting in Illustrator, 

220–224
starting in Photoshop, 

225–226
states, 215
testing scrollbar, 234
Timeline panel, 238
Transform panel, 221
transitions, 215, 239–242
wireframe components, 

215, 233, 235
Flash Exchange, 13
Flash Professional

adding animations to 
symbols, 260–262

Bone tool, 258
brushes, 256
code snippets, 263–264
creating text columns, 255
Dampening settings, 258
Deco tool, 256–257
drawing effects, 256
embedding fonts in, 253
exporting FXG files, 

250–251
FLVPlayback  

component, 266
Import dialog box, 246
Import to Stage dialog 

box, 294–295
imported artwork, 247



340

I n d e x

fireplace illustration, 98, 100
getting pixel dimensions 

in, 124
Graphic Styles, 121–122
Graphic Styles in, 122
Isolation Mode, 227
moving objects between 

planes, 94
one-point perspective, 88
Perspective Drawing 

feature, 88, 93–97
perspective grid, 88–89
Perspective Selection  

tool, 94
relocating width points, 99
round-trip editing in, 

227–228
rulers, 114
scalable Web and print 

graphics, 125–126
Scale Strokes & Effects, 6
scaling guides, 126
setting preferences  

in, 6–7
Shape Builder tool, 

105–107
Shape tool, 106
sharing color swatches, 

283–284
simulating cast shadow 

in, 97
Slice Selection tool, 126
Smart Guides, 6–7
stacking order in, 108–110
starting Flash Catalyst in, 

220–224
station points of 

perspective grids, 90
Stroke panel options, 100
stroke weight values, 100
support for Kuler, 14

Illustrator. See also 
appearances; perspective 
grids
9-slice Scaling, 125–126
Active Plane Widget, 93
adding arrowheads to 

strokes in, 103–104
adding fills, 120
adding strokes, 120
adding width points to 

paths, 98
Appearance of Black 

preferences, 7
appearances, 118–122
artboards, 114–117
ASE access in, 284
automating with actions, 

298–300
Character panel, 124
combining shape areas 

in, 107
components of 

perspective grids, 90
creating artwork for  

Web, 123–124
creating Bristle brushes  

in, 111–113
creating dashed  

strokes, 101–102
creating variable-width 

strokes in, 98–100
customizing perspective 

grid in, 89–92
Draw Behind mode, 

108–110
Draw Inside mode, 108–110
drawing in perspective, 

93–97
drawing objects in, 121
Exchange, 13
Fidelity options for Flash 

Catalyst, 222–223

graphics, Web and print, 
125–126

GREP style, using with forms, 
278–281

grids. See perspective grids
Group Object Selection mode, 

using in InDesign, 132
guitar illustrations, 118, 120

H
H.264 codec, 230
HDR (High Dynamic Range) 

photography, 52
HDR effects, creating, 54
HDR Toning command, using 

in Photoshop, 52–54
HH value, displaying for 

perspective grids, 92
HTML documents, using 

BrowserLab with, 179
HTML files, exporting from 

InDesign, 157
HTML pages, creating from 

starter layouts, 173
HTML5, 202–207

browser support, 203
defining rounded corners, 

205–207
DOCTYPE declaration, 203

HTML5 coding, speeding  
up, 204

HUD Color Picker, using in 
Photoshop, 58

I
ICC color profile, including, 302
ID, setting up, 17–18
IIlustrator artwork, converting 

to components, 233–234
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editing motion paths, 154
envelope master  

pages, 131
Exchange, 13
exporting HTML files  

from, 157
Form Field Recognition, 278
form layout in, 277
Gap tool, 140–141
generating metadata 

captions with, 274–276
gridified behavior, 142–143
gridified tools, 142–143
Group Object Selection 

mode, 132
handling of files in, 70
Illustrator layers, 288–293
Indents and Spacing 

options, 135
interactive PDFs, 159–162
interactive slide shows, 

146–150
Kerning/Tracking setting, 8
Keyboard Increments, 8
Kuler themes, 16
Layers panel for groups, 

132–133
Layers panel vs. Selection 

tool, 132
leading preferences, 8
letterhead master  

pages, 131
Live Corner effects, 

144–145
Live Distribute, 139
Live Screen Drawing 

setting, 138
Master Page Overlay, 130
Media panel displaying 

video, 160
mixing multistate  

objects, 147

video in Flash  
Professional, 266

InDesign
Acrobat forms, 277–292
adding presets, 154
adding space before/space 

after, 135
aligning frames for slide 

shows, 147
Animation  

Encyclopedia, 155
animation for Web, 

151–155
animation interface, 152
beer glass animation, 

151–155
business card master 

pages, 131
butterfly animation, 153
button appearances, 148
button behavior, 149
button capabilities, 149
Buttons panel, 148
Caption Setup dialog box, 

274–276
combining graphic  

frames, 147
consolidating old 

documents, 131
Content Grabber, 137–138
Control panel in Page 

mode, 128
Controller options for FLV 

video, 160
Corner effects, 144–145
creating duplicates, 143
creating stationery 

packages, 131
creating templates, 131
deleting pages in, 116
designing print  

brochures in, 10

switching between planes 
in, 94

three-point perspective, 89
two-point perspective, 88
using symbols with Flash 

Catalyst, 222–223
Width Profile, 99–100
Width tool, 98–100

Illustrator artwork,  
rasterizing, 223

Illustrator files, importing into 
Flash Professional, 246–248

Illustrator layers, using in 
InDesign, 288–293. See also 
layers

image noise, reducing, 72
Image Processor

in Adobe Bridge, 301–302
file formats, 302
in Photoshop, 301–302

images, loading as  
selections, 37

imported bitmaps, editing in 
Photoshop, 249

importing. See also exporting
ASE swatches, 284
Audio into Flash  

Catalyst, 231
code snippets as XML, 264
FXG files, 250–251
options in Flash 

Professional, 246, 
294–295

options in Illustrator, 
222–224

options in Photoshop, 
225–226

Illustrator files, 246–248
Photoshop files,  

246–248, 296
Photoshop layers, 248
video in Flash Catalyst, 231
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J
JPEG compression, 157
JPEG options, setting for 

EPUB, 165
JPEGs

opening in Camera Raw, 34
processing in Camera Raw, 

24–25
rendering by BrowserLab, 

180

K
keyboard shortcuts

Artboard tool, 116
BrowserLab, 182
Brush panel in Photoshop, 

56
brushes in Photoshop, 

59–60
Camera Raw, 24
copying type layer, 64
for Gap tool, 141
Graphic Styles in  

Illustrator, 121
layouts in Dreamweaver, 

173
moving objects between 

planes, 94
moving objects to  

layers, 43
opening Camera Raw 

images, 25
page ranges in  

InDesign, 128
perspective grid in 

Illustrator, 88
Perspective Selection tool 

in Illustrator, 94
preferences, 5
scripts, 304–305

Kuler extension, 14–16

sharing color swatches, 
283–284

Span Columns dialog, 
134–135

Span/Split columns, 
134–136

Super Step-and-Repeat, 
142–143

support for FLV video, 160
support for MOV  

format, 159
Timing panel for 

animations, 155
Units and Increment, 8
using Mini Bridge  

in, 31–32
using objects, 137–139

InDesign export
for EPUB, 163–167
to Flash Professional, 

156–158
interactive PDF with video, 

159–162
to SWF, 156–158

index.php file, opening in 
WordPress, 194

.indt file, explained, 131
interactions

creating in Flash Catalyst, 
236–237

triggering, 237
interactive content. See Flash 

Catalyst
Inverse Kinematics, using with 

Flash Professional, 258–259. 
See also animations

iPad, displaying pages on, 212
iPhone, displaying pages  

on, 212
Isolation Mode, using in 

Illustrator, 227

InDesign (continued)
modifying negative  

space, 140–141
motion presets, 154
moving objects in  

frames, 138
multiple page sizes, 

128–131
naming animations, 154
navigation points for 

video, 161
New Document dialog, 151
Object Layer Options, 291
Object Styles, 145
Page tool, 128
Paste in Place  

command, 290
Photoshop layers in, 

288–293
place gun, 142
Place PDF dialog box, 

292–293
placing Buzzword 

documents in, 316–317
poster frame for  

movie, 160
Preview panel, 150
Printing and Proofing 

workspace, 10
redistributing space 

between objects, 139
repositioning pages, 129
resizing objects, 139
resizing pages, 129
rotating selected  

objects, 138
rotation cursor, 138
scaling objects, 139
Scripts panel, 155, 303–305
selecting object ranges, 133
selecting page ranges, 128
setting preferences in, 8
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saving, 262
using in Flash Professional, 

260–262
movie clips, using in Flash 

Professional, 295
MP3 codec, 231–232
Multiscreen Preview, using in 

Dreamweaver, 210–212

N
negative space, modifying in 

InDesign, 140–141
NetAverages, 326–331
noise, reducing, 72

O
Object Styles, creating in 

InDesign, 145
objects

drawing in Illustrator, 121
grouping in InDesign, 132
moving to layers, 43
redistributing space 

between, 139
resizing in InDesign, 139
rotating in perspective, 96
scaling in InDesign, 139
scaling in perspective, 94

On Application Start 
interaction, 237

On2 VP6 codec, 230
online review

adding comments to, 321
creating, 318–322
inviting client 

participation, 320
jumping to comments, 322
naming, 318
replying to comments, 322
Share dialog box, 320–321

using with Dreamweaver, 
186–187

lossy compression, 157
Lynda.com videos, 16

M
masks

hiding in Photoshop, 50
making in Photoshop, 

48–51
Master Page Overlay, using in 

InDesign, 130
media queries

defined, 209
examples of, 210

menus, customizing, 11
metadata, defined, 274
metadata captions, 

generating, 274–276
Mini Bridge. See also Bridge

opening files in Camera 
Raw, 34

showing linked files in, 32
using in InDesign, 31–32
using in Photoshop, 33–34

Mixer brushes. See also 
brushes
opacity shortcuts, 62
using in Photoshop, 55–62

mobile devices, displaying 
pages on, 209–212

mobile trends, tracking, 
326–331

mock-ups, creating for 
products, 82–85

motion paths, editing in 
InDesign, 154

motion presets. See also 
presets
creating, 262
number of frames in, 261

L
Layer Comps feature, 226
layer masks, using with 3D 

Repoussé, 66
layers. See also Illustrator 

layers; Photoshop layers
adding in Photoshop, 55
assigning appearances to, 

121–122
creating in Photoshop, 39
moving objects to, 43

Layers panel, using with 
groups in InDesign, 
132–133

layouts. See starter layouts
Lens Correction filter, using in 

Photoshop, 75–76
letterhead master pages, 

creating in InDesign, 131
LightBox Gallery  

Widget, 191, 193
Linear easing style, 241
linked files. See also files

showing in Bridge, 32
showing in Mini Bridge, 32

Live Code, using with 
Dreamweaver, 186–187, 196

Live Corner effects, using in 
InDesign, 144–145

Live Distribute feature, 139
live effects, as appearances, 118
Live Paint vs. Shape  

Builder, 105
Live Screen Drawing setting, 

using in InDesign, 138
Live View

activating in Dreamweaver, 
183–185

Spry accordion code, 186
using in Dreamweaver, 

195–196, 211
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changing brush sizes in, 
59–60

Clone Stamp tool, 40–41
Content-Aware Fill, 36–41
Content-Aware Scaling, 36
creating 3D mock-up, 82–85
creating brushes in, 57
creating layers in, 39
creating watermarks in, 30
decreasing color noise  

in sky, 72
editing imported  

bitmaps in, 249
Exchange, 13
versus Flash  

Professional, 296
HDR (High Dynamic 

Range) photography, 52
HDR Toning command, 

52–54
hiding masks in, 50
HUD Color Picker, 58
Image Processor, 301–302
Kuler extension, 15
Lens Correction  

filter, 75–76
making masks, 48–51
making selections, 48–51
Mixer brushes, 55, 61–62
opening Fill dialog box  

in, 37–38
opening raw images in, 25
pixel grid, 123
Puppet Warp, 42–47
Quick Mask mode, 48
Refine Edge tool, 48–51
Refine Mask tool, 48
Refine Radius tool, 49
resizing fonts in, 6
round-trip editing in, 

228–229

stroke problem related 
to, 97

understanding, 88–89
Perspective Drawing feature, 

using in Illustrator, 93–97
perspective grids. See also 

Illustrator
changing opacity of, 91
common components 

of, 90
customizing in  

Illustrator, 89–92
defining, 91–92
modifying text on, 95
moving vanishing  

points of, 91
presence of, 89
station points of, 90
using in Illustrator, 88–89
using Smart Guides  

with, 92
using symbols on, 95–96

Perspective Selection tool, 
using in Illustrator, 94

phone.css file, 211
Photoshop

3D Repoussé, 63–66
accessing brush tool in, 56
adding colors in, 58
adding layers in, 55
Application Frame, 67
applying Smart Filters 

in, 73
automating with  

actions, 298–300
Bristle brushes, 55–60
brush shortcuts, 59–60
brush-tip properties, 55
changing brush  

color, 58–59
changing brush hardness 

in, 59–60

online review (continued)
Upload Settings dialog 

box, 318
opacity

changing for perspective 
grids, 91

setting for tools, 62
Opera browser, 206–208

P
page layout applications. See 

also InDesign
conventions of, 137
switching tools in, 137

Page tool, using in  
InDesign, 128

pages, repositioning in 
InDesign, 129

painting, guidelines for, 55
panels, arranging, 11
panorama, using Content-

Aware Fill with, 36–41
paragraph styles, using Span/

Split columns with, 134
parallax distortion, fixing in 

Camera Raw, 78
Pathfinder vs. Shape  

Builder, 105
paths

appearances applied  
to, 118

selection of, 119
PDF, interactive, 161
PDF contact sheets, creating 

with Bridge, 312–313
PDF with video, exporting, 

159–162. See also video
perspective

drawing in, 93–97
rotating objects in, 96
scaling objects in, 94
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presets. See also motion 
presets
adding in InDesign, 154
adding to pages, 193
using with widgets, 192

Preview panel, using in 
InDesign, 150

print graphics, scalable, 
125–126

procedural drawing, 256
PSD files, resizing, 287
publishing profiles, using in 

Flash Professional, 269
Puppet Warp, using in 

Photoshop, 42–47
purple cat, warping, 42–46

Q
Quick Selection tool, using 

with Puppet Warp, 42

R
radio buttons, including on 

forms, 280–281
raw images

advantages of, 77
editing with Camera  

Raw, 77–81
opening in Camera Raw, 24

reading devices, delivering 
books to, 163–167

Refine Edge tool, using in 
Photoshop, 48–51

Refine Mask tool, using in 
Photoshop, 48

Refine Radius tool, using in 
Photoshop, 49

Repoussé feature, 63–66
Review service. See online 

review

invoking, 198
in related files, using with 

Dreamweaver
tooltips, 199
using to determine 

browser support, 206
using with Dreamweaver, 

197–201
PHP functions, getting 

information about, 200
PHP include, 198
PHP pages, using with 

Dreamweaver, 195
pins, using with Puppet Warp, 

42, 44, 46
pixel dimensions, getting in 

Illustrator, 124
pixel grid

aligning artwork to, 
123–124

displaying in Photoshop, 
123

place gun, using in InDesign, 
142

Place PDF dialog box
Art option, 293
Bleed option, 293
Bounding Box options, 293
Crop option, 293
Crop To menu, 293
Media option, 293
Trim option, 293

plug-ins, downloading, 12–13
PNG compression, 157
Power easing style, 241
preferences

navigating by keyboard, 9
setting in Dreamweaver, 9
setting in Illustrator, 6–7
setting in InDesign, 8
setting in Photoshop, 5

round-trip editing with 
Flash Professional, 249

setting preferences in, 5
sharing color swatches, 

283–284
Smart Objects, 70–74
starting Flash Catalyst  

in, 225–226
using Mini Bridge  

in, 33–34
vanishing point for 3D 

mock-up, 82–85
zooming in, 123

Photoshop CS2, Layer  
Comps, 226

Photoshop files
importing as editable  

text, 296
importing into Flash 

Professional, 246–248
Photoshop filters. See also 

filters
applying to video, 67–69
final render process, 69
using Animation panel 

with, 68
Photoshop images, linking to 

Dreamweaver, 285–287
Photoshop Import Options

image layers, 225
shape layers, 225
text layers, 226

Photoshop layers. See also 
layers
importing to Flash 

Professional, 248
preserving in Flash, 

294–296
using in InDesign, 288–293

Photoshop styles, preserving 
in Flash, 294–296

PHP code hinting
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Smooth Transition Options 
panel, 239–240

social networking sites, 
exporting to, 26

Sorenson Spark codec, 230
Span/Split columns, setting 

up in InDesign, 134–136
Spot Healing Brush tool, using 

with Content-Aware Fill, 39
Spry accordion code, 186
sRGB default color space, 3
St. Peter’s Basilica, 46–47
stamps, using with  

forms, 306–308
starter layouts

HTML5, 202–203
using in Dreamweaver, 

173–175
stationery packages, creating 

in InDesign, 131
strokes

adding arrowheads to, 
103–104

adding in Illustrator, 120
as appearances, 118
dashed, 101–102
distribution in  

Illustrator, 124
swatches. See color swatches
SWF (Shockwave-Flash) 

format, 268
ActionScript in, 158
exporting to, 156–157

symbols
adding animations to, 

260–262
saving artwork as, 123
using on perspective  

grid, 95–96
using with Flash Catalyst, 

222–223

shadows, defining, 205–207
Shape Builder tool

Color Swatch Preview, 106
vs. Live Paint, 105
vs. Pathfinder, 105, 107
using in Illustrator, 105–107

Shape tool, using in  
Illustrator, 106

Shockwave-Flash (SWF) 
format, 268
ActionScript in, 158
exporting to, 156–157

silhouettes. See Refine 
Edge tool

Sine easing style, 241
SiteCatalyst NetAverages 

service, 17, 326–331
sites. See also Web sites

adding servers  
for, 170–172

column layouts of, 174
sky, decreasing color noise 

in, 72
Slice Selection tool, using in 

Illustrator, 126
slide shows, creating in 

InDesign, 146–150
Smart Filters, applying, 73.  

See also filters
Smart Guides

using with artboards, 116
using with perspective 

grids, 92
Smart Objects

converting video to, 68
source files, 286
using in Photoshop, 70–74
using to link images, 

285–287

RGB working space,  
changing to, 3

Rollover appearance, adding 
to buttons, 148

rotating objects in 
perspective, 96

rotation cursor, using in 
InDesign, 138

rounded corners, defining, 
205–207. See also Corner 
effects

round-trip editing
in Illustrator CS5, 227–228
in Photoshop CS5, 228–229
preserving fidelity  

in, 228–229
using in Flash Catalyst, 

227–229

S
scaling with Transform tool, 83
scratch disks, setting up, 6
screen sharing, 323–325
screen shots

delaying in BrowserLab, 
182

saving in BrowserLab, 182
scripts

CropMarks, 304
triggering, 304–305
using in InDesign, 303–305

selecting versus targeting, 119
selections

loading images as, 37
making in Photoshop, 

48–51
servers, adding for Web sites, 

170–172. See also test 
server
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setting properties for Flash 
Catalyst, 232

Video Import Wizard, 266

W
watermarks

adding in Bridge, 30
adding in Photoshop, 30
using email addresses 

as, 30
Web

browsing with 
Dreamweaver, 186–187

creating artwork for, 
123–124

Web analytics, 326–331
Web animation, creating in 

InDesign, 151–155
Web designs, 164, 183–185
Web galleries, creating in 

Bridge, 309–311
Web graphics, scalable, 

125–126
Web sites. See also sites

Acrobat.com CS Live 
service, 17

Adobe Developer 
Connection, 174

Adobe Labs, 13
Adobe Marketplace & 

Exchange, 12–13
Adobe TV, 16
Kuler support for 

Dreamweaver, 16
scripts, 303
templates, 175
testing servers, 194
WordPress, 194

easing styles, 241
establishing in Flash 

Catalyst, 239–242
repeating effects, 242

trends, tracking on Web, 
326–331

type
enhancing in Flash 

Professional, 252–253
improved composition 

options, 254
type layer, copying, 64

U
updates, keeping up with, 

19–20

V
vanishing point

for 3D mock-up, 82–85
moving in perspective 

grids, 91
vector images, editing in Flash 

Catalyst, 227–228
video. See also PDF with video

applying Photoshop filters 
to, 67–69

applying texture to, 68–69
converting to Smart 

Object, 68
encoding for Flash 

Catalyst, 230
importing into Flash 

Catalyst, 231
in interactive PDFS, 160
playing in Flash 

Professional, 265–267

T
tablet.css file, 211–212
targeting appearances, 119
templates

downloading, 175
using in InDesign, 131

test server, setting up for 
Dreamweaver, 194. See also 
servers

text, modifying on perspective 
grids, 95

text frames, animating in 
InDesign, 154

 “Thirsty” animation, 152, 
154–155

TIFFs
opening in Camera  

Raw, 34
processing in Camera  

Raw, 24–25
Timeline panel, using in Flash 

Catalyst, 238
Timing panel, using with 

animations, 155
TLF (Text Layout Format), 

using in Flash Professional, 
252–253

TLF text, threading, 253
Tour state, using with button 

interaction, 236–237
Transform tool, scaling  

with, 83
transition effects, adding with 

Timeline panel, 238
transitions

adjusting duration  
of, 241

adjusting timing of, 242



Web trends, tracking,  
326–331

WebKit layout engine, use 
with Dreamweaver, 186

weight-loss, creating 
appearance of, 75–76

Widget Browser, using with 
Dreamweaver, 188–193

widgets
choosing, 190
customization options, 

190–191
displaying details  

about, 190

saving settings as  
presets, 192

Width tool, using in  
Illustrator, 98

wireframes, converting to 
components, 235

WordPress
index.php file, 194
online tutorial, 194
opening pages from, 194

workspaces
setting up, 10–11
using, 10–11

X
XHTML format, using with 

EPUB, 166
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Meet Creative Edge. 
a new resource of unlimited 

books, videos and tutorials for 

creatives from the world’s  

leading experts.

creative edge is your one 

stop for inspiration, answers to 

technical questions and ways to 
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you can focus on what you do 

best—being creative. 

all for only $24.99 per month  

for access—any day any time  
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